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Challenge Image: Umbrella 

In this lesson, we’re going to work on a challenge image that was sent in by a 
Masters Academy member. We’ll cover a variety of Photoshop features, as well as 
a technique for recovering detail in overly bright areas. 

Process the Image in Camera Raw

Before working in Photoshop, 
we’ll first process the image 
in Camera Raw. The image is 
a raw file, so we can simply 
double-click on its thumbnail 
in Bridge in order to open it in 
Camera Raw. 

WHITE BALANCE

We’ll first adjust the white bal-
ance of the image. We’ll use 
the White Balance Eyedrop-
per to click on an area that 
is supposed to be a shade of 
gray. This might take a few tries, clicking in different locations, to find an area that 
makes the image look good. Then, we can fine tune the white balance using the 
Temperature and Tint sliders. 

RECOVER HIGHLIGHT DETAIL

Next, we’ll attempt to recover some of the highlight detail in the bright umbrella 
and the pavement in the foreground. The following settings can be used to re-
cover highlight detail:

In this challenge image, we will attempt to recover  
highlight detail in the overly bright areas. 
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The Whites slider The Whites slider controls how bright the brightest part of the 
picture is, so we’ll move that to the left. 

The Highlights slider This slider controls the brighter areas of the image (that 
aren’t pure white) so we’ll move this to the left as well. Be careful with this slider, 
however, as it’s easy to create and unnatural look by moving it too far.

The Contrast slider The Contrast slider controls the difference between the re-
ally bright and really dark areas. Moving it to the right will make the bright areas 
brighter and the dark areas darker. We’re going to move it to the left, which will 
make the dark and bright areas more similar in tone. This helps to darken the re-
ally bright areas as well as lighten the shaded areas, including the man/subject in 
the image. 

The above initial adjustments were made in Camera Raw. 
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Additional image adjustments There are a few additional adjustments I like to 
make in Camera Raw. These will vary from image to image, but the following ad-
justments will be applied to our challenge image:

• Increase Clarity to make the details pop

• Increase Vibrance to make the image a little more colorful 

• Remove chromatic aberration (under Optics Panel): Removes any color fring-
ing artifact that sometimes occurs along edges in high-contrast areas  

• Use profile corrections (under Optics Panel): Corrects any distortion caused 
by the lens

Geometry Upright setting Under the Geom-
etry Panel, the Upright setting (far right icon) 
can be used to manually correct the horizontal 
and vertical lines in the image. When the tool is 
active, click and drag on the lines that should 
be perfectly vertical and horizontal. After cre-
ating two lines, Camera Raw will attempt to 
straighten the image based on those guides. 
You can draw out a maximum of four lines. In 
the challenge image, we used this to ensure 
that the vertical lines in the building were per-
fectly vertical. 

Open Image as Smart Object in Photoshop

Now that we’re done making the initial adjustments in Camera Raw, we are going 
to open the image as a smart object in Photoshop. By opening the image as a 
Smart Object, we will have a complete copy of the original raw file embedded in 
the layer. Therefore, we can return to Camera Raw and change the settings later.

The Upright setting allows you to 
draw out lines, defining areas that 
should be perfectly horizontal or 
vertical.
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If we were to simply click on the Open 
button in the bottom right corner of 
Camera Raw, it would open the image 
as a regular layer. In order to open the 
image as a Smart Object, we need to 
hold down the Shift key while clicking 
the button. When holding down this key, 
the Open button turns into the Open 
Object button. 

Process Image a Second Time for Bright Areas

In the challenge image, I believe that it was overexposed too much so that we’re 
not going to get true fidelity in that area. However, we can still adjust the area so 
that it doesn’t look quite as bright. 

To do this, we’re going to process the image a second time. In this second pass, 
we’re only going to concentrate on the bright part of the umbrella. We will ignore 
the rest of the image because we will eventually mask this second layer so that 
the umbrella is the only visible area. 

In order to create a second version of the image, 
we need to copy the smart object layer in a special 
way. If we were to simply duplicate the layer, it would 
create a second instance of the smart object, where 
anything done to one of the smart objects will also 
be applied to the other. That’s not what we want. We 
want to be able to adjust the two versions separately 
from one another. To get this, we’ll click on the Layer 
menu and choose Smart Object > New Smart Object 
via Copy. Now we can make changes to the copy and 
the original smart object layer will not be affected.  

ABOVE: The Shift key 
is held down to access 
the Open Object button. 
LEFT: The lower right 
icon indicates that the 
layer is a smart object.

We duplicated the image layer 
as a new smart object that can 
be adjusted independently of 
the original smart object.
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We’ll now double-click on that new, top layer in order to open it in Camera Raw. 
Here, we will process the image to make the bright umbrella look good. The rest 
of the image will end up looking bad, but that’s ok. We’ll mask the layer later. 

Because the bright area is blown out to white, we need to determine what color 
should appear there. Looking at the umbrella, the area is probably pink, but I vi-
sually think it might look most natural if we were apply some yellow. 

We’ll open the Curve Panel on the right side of Camera Raw’s interface. There 
are a few colored icons above the curve and these determine what color we’ll be 
working on. By default, the gray icon will be selected, which means that we’ll be 
working on the overall brightness. Because we want to add some yellow, we’ll 
click on the blue icon to make it active. Yellow is the opposite of blue, so this 
curve will allow us to control both the blues and yellows. If we were to add blue 
(by moving the curve line up), we’d be removing yellow. If we were to remove 
blue, we would be adding yellow. The far right side of the curve line represents 
the brightest part of the image. That’s the area we want to adjust, so we’ll click on 
that top right curve point and drag it down a bit. This adds some yellow into the 
highlights of the image. You can see that the bright part of the umbrella starts to 
become yellow. 

The blue curve is selected and we are moving the far right point downward. This is adding 
yellow to the brightest parts of the image.



Challenge Image: Umbrella © Ben Willmore, All rights reserved 7

We can take it a little further by dragging more of the curve down toward yellow. 
This will cause it to affect a greater tonal range. We’ll choose a spot that’s about 
3/4 of the way from the left to the right side, we’ll click on the curve line and drag 
down, paying attention to its affect on the umbrella. 

When we’re satisfied with the umbrella, we’ll click the OK button in order to re-
turn to Photoshop’s main interface. 

Mask the Duplicate Layer

Back in Photoshop, the entire image will look yellow because that entire top layer 
that we just adjusted is visible. We need to mask the layer so that the umbrella is 
the only visible part. When it comes to layer masks, the white parts of the mask 
represent the parts of the layer that are visible. The black parts of the mask rep-

Another point is being dragged down on the curve. This is adding yellow to a broader tonal 
range.
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resent the parts of the layer that are not visible. In this instance, it will be easier 
for us to start with a completely black mask and then add white in the parts of 
the layer that should be visible. To create a black mask, we’ll hold down the Op-
tion key (Alt on Win) while clicking on the Layer Mask icon at the bottom of the 
Layers Panel. Next, we’ll activate the Brush Tool and paint with white on the areas 
that should be visible. This is the bright part of the umbrella. This will reveal that 
yellow layer in the area where we paint. 

We created a black layer mask, which hides the entire layer. Here, we are painting with white 
on the mask in order to reveal the yellowing effect on the bright part of the umbrella.
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Curves Adjustment to Correct Other Bright Areas

Now that the umbrella is looking better, we’ll move on to correct some other 
parts of the image. The pavement in the foreground and the wall on the left side 
of the frame are both very bright. I find that this draws attention away from the 
main subject, so we’ll try to darken these areas a bit. 

We’ll create a Curves Adjustment Layer by clicking on the Adjustment Layer icon 
at the bottom of the Layers Panel (It looks like a circle that’s half black, half white) 
and choosing Curves. The new adjustment layer will appear at the top of the Lay-
ers Panel and the Curves Properties Panel will be open.

The top right corner of the curve line 
represents the whites in the image. If we 
were to move that point down, we’d be 
telling it to take the areas that used to 
be white and darken them to whichever 
tone we place the point on (looking at 
the vertical gradient on the left side of 
the curve chart).  We’ll move that point 
down until those bright areas start to 
look more subdued. 

Next, we need to mask the adjustment 
layer so that the foreground and left 
wall are the only areas affected by the 
adjustment. Whenever you create an 
adjustment layer, there is automatically 
a white mask applied. This means that 
the adjustment will be applied to the 
entire layer unless we add black to the 
mask. We’d like to start with a complete-
ly black mask so we’ll invert the mask by clicking on the Image menu and choos-
ing Adjustments > Invert. The mask will become black and the adjustment will be 
completely removed from the image. We’ll then activate the Brush Tool and paint 
with white on the areas that should receive the darkening adjustment. 

For this Curves Adjustment Layer, we are 
dragging the top, right curve point down. 
This is darkening the areas that used to be 
white in the image.
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Retouch Additional Problem Areas

There is still one part of the wall that is very bright and distracting. It’s complete-
ly blown out to white, so a regular darkening adjustment will not be effective. 
Because it’s a small area, however, we can use our retouching tools to correct 
the spot. We’ll create a new, empty layer at the top of the Layers Panel and we’ll 
activate the Clone Stamp Tool. With this tool active, some settings will appear in 
the Options Bar above the main image window. We need to make sure that the 
Sample menu is set to Current & Below. This will allow us to use the Clone Stamp 
Tool on an empty layer. 

Using the Clone Stamp Tool, we’ll sample from an area of the wall that has detail 
by holding down the Option key (Alt on Win) and clicking on the area. Then, we’ll 
release the Option key and paint in the sampled content over that bright area. 

The mask for the adjustment layer was filled with black and here we are painting with white 
in the areas that should receive the darkening effect. 
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Now we’re going to do two things to lessen the effect of this retouch layer. First, 
we’ll change the blending mode of the layer to the Darken mode. (The Blending 
Mode menu is located at the top of the Layers Panel.) This will make it so the lay-
er is only capable of darkening the underlying image. It can’t brighten it. Second, 
we’ll lower the Opacity of the retouch layer, setting it at the lowest setting that 
still removes the distracting highlight. 

FAR LEFT: The Clone 
Stamp Tool is being 
used to sample an area 
of the wall that has 
detail. 

DIRECTLY LEFT: The 
tool is then used to 
paint the sampled  
content over the area 
that needs retouching.

The blending mode 
of the retouch layer 
is set to darken and 
the Opacity is being 
lowered in order to 
lessen the effect.
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Correct Highlight in Hat

Now we’re going to move on to an-
other part of the image. There is a 
hat sitting on the table and it has a 
highlight that looks to be blown out, 
containing no detail. Let’s see what 
we can do to correct this. 

The best way to regain highlight 
detail is to work on the raw image 
in Camera Raw. We can do that be-
cause our image layer is a smart ob-
ject. We’ll duplicate the original smart object layer that contains the original im-
age. It should be at the bottom of the Layers Panel. Again, we will duplicate the 
smart object by clicking on the Layer menu and choosing Smart Objects > New 
Smart Object via Copy. This will allow us to adjust this new layer without the 
changes affecting the original smart object layer. 

We’ll drag the new copy to the top of the layer stack and double-click on its 
thumbnail in order to open the image layer into Camera Raw. We’ll zoom in on the 
hat so we can better see the effect of our adjustments. We’ll drag the Exposure 
slider down to see if we can restore detail in the brightest spot on the hat. We do 
get some detail, but not color. This tells me that the camera only captured detail 
in one or two of the three color channels (red, green and blue).

We will use Camera Raw to attempt to recover 
detail in the overly bright part of the hat.

The tonal sliders were used to bring detail back to the bright part of the hat. 
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We’ll try to inject some yellow into the area lacking color by using the Curve Panel 
in Camera Raw. With the Curve Panel open, we’ll click on the blue icon at the top 
of the panel in order to work on the blue curve. Remember, the blue curve will 
control both blue and yellow (blue’s opposite). The top right point on the curve  
controls the brightest parts of the image, so we’ll drag that point down. This adds 
some yellow into the bright spot on the hat. 

The problem is that the area of medium bright-
ness starts to become TOO yellow. We can use the 
Curve to correct this. We’ll activate the Targeted 
Adjustment Tool, which is located above the top 
right corner of the curve chart. We’ll click on the 
area that became too yellow and drag up. What 
this does is add a point on the curve, representing 
the targeted tone, and moves that point upward, 
toward blue. We’ll drag up until the curve point is 
located in its original position, before we moved 
the first dot. Know that you can also move a curve 
point by using the arrow keys on your keyboard.

The blue/yellow curve is being used to add some yellow to the brightest part of the hat.

A point was added to the curve 
to remove the yellow effect from 
the areas of medium brightness.
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Note: If you know that you only want to affect a small brightness range, you can 
initially click on the curve line to place a point on the tone that you do NOT want 
to be affected. By placing a point, you will be locking that point in place and pre-
venting that tone from shifting when you made additional changes to the curve. 

Now we have a Curves adjustment that is adding yellow to only the absolute 
brightest portions of the image. We’ll click OK to exit Camera Raw and return to 
Photoshop. 

The adjustment affected the en-
tire image and we only wanted 
it to be visible in the bright area 
of the hat. We’ll use a layer mask 
to hide the adjustment in all oth-
er areas. We’ll start with a black 
mask that hides the entire layer. 
Remember, you can create a black 
mask by holding down the Option 
key (Alt on Win) while clicking the 
Layer Mask icon at the bottom of 
the Layers Panel. Then, we’ll acti-
vate the Brush Tool and paint with white just over that bright part of the hat that 
we want to be adjusted. We won’t worry about being really precise, because 
we’re going to take another step that will limit the adjustment to that bright area. 

We’ll click on the FX icon at the bottom of the Layers Panel and choose Blending 
Options. This will open the Layer Style dialog and the Blending sliders will be near 
the bottom. These sliders will allow us to limit where a layer is visible based on 
brightness. The underlying layer slider will base the adjustment on the underlying 
image, and that’s what we’ll use. If we drag the black slider to the right, it will hide 
the layer in all areas where the underlying layer is darker than the active layer. 
We’ll drag it to the right until we can see the affect disappear from the darker 
part of the hat. 

The darkened layer was hidden with a black layer 
mask and we are painting on the mask with white 
to reveal the darkening effect on the bright spot. 
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The transition will look very abrupt and we can fix this by splitting the slider 
into two halves. When the slider is split, the transition happens between the two 
halves. The farther apart those two halves are, the more gradual the transition will 
be. You can split the slider in half by holding down the Option key (Alt on Win) 
and dragging one half of the slider away from the other. In the example image, we 
dragged the right half of the slider all the way to the right, so that the transition 
looked natural. 

In the Layer Style dialog, the Blending Sliders are being used to hide the darkening layer in 
the areas where the underlying layer is darker. 

The Blending Slider was split in half in order to create a more gradual transition between the 
parts of the layer that are visible and the parts that are not. 
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Introduce More Detail into Umbrella

We’re going to try to bring out more detail into the bright part of the umbrella. 
We can just barely make out the details in the umbrella, but because we can see 
a slight hint of some shapes, that tells me that we could see more by looking at 
the individual channels. We’ll open the Channels Panel, which is grouped with the 
Layers Panel by default. 

We need to view the contents of the individual channels and we can do that 
simply by clicking on the names of the channels. Note that you will sometimes 
need to click on the top-most RGB channel first. Then you can click through the 
individual color channels. 

We’ll click through the channels, looking to find the one that creates the most 
separation between the objects in the bright part of the umbrella. This ended up 
being the Red channel. With this channel active, we’ll try to select the little tree 
shapes in the umbrella by creating a channel mask. 

We were best able to see the shapes in the bright part of the umbrella when viewing the Red 
channel. 
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We’ll start by duplicating the red channel by dragging its thumbnail to the New 
icon at the bottom of the Channels Panel. We’ll then adjust the duplicate using 
the Levels or Curves adjustment. In the video example, we used the Levels ad-
justment. We’ll use the Eyedropper icons, which are found in both the Levels and 
Curves adjustments. We’ll activate the black eyedropper, which forces areas to 
black, and we’ll click on the lightest part of dark area that we want to adjust. Next, 
we’ll activate the white eyedropper and use it to click on the darker portion of 
the lightest area we want to adjust. This will force the area to become white. We’ll 
click OK to exit the Levels dialog. 

Now we will further adjust the channel, trying to get the object we want to select 
(the tree shape) to become solid black, and everything surrounding it to become 
solid white. We’ll use the Lasso Tool to make a rough selection around the area 
we want to focus on. This is the area containing the tree shapes. We really want 
the inverse of this, so that everything EXCEPT the trees are selected, so we’ll 
click on the Select menu and then choose Inverse. We will fill that outside area 
with white by clicking on the Edit menu and choosing Fill. When the Fill dialog 
opens, we’ll choose white from the Contents menu and then click OK. Now, ev-

In the Levels adjustment, the Black and White Eyedroppers were used to force areas to solid 
white and solid black.
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erything in the channel is white except for 
the tree shapes we want to isolate. We’ll 
use the Brush Tool to clean up what’s left. 
We’ll paint with white on the areas that 
surround the trees. 

White represents the area that’s selected 
and black represents the areas that are 
not selected, so this is the exact oppo-
site of what we want. We want the tree 
shapes to be selected so we’ll click on the 
Image menu and choose Adjustments > 
Invert. Now the trees are the only white 
part of the channel. 

We need to load this channel as a selection and we can do that by dragging the 
channel thumbnail to the selection icon at the bottom of the Channels Panel. The 
“marching ants” selection will appear around the shapes. We can now return to 
viewing the normal view of the image by clicking on the top-most RGB channel. 
We can next return to the Layers Panel and make an adjustment to the selected 
area.

I like using the Curves adjustment for tasks like this so we’ll click the Adjustment 
Layer icon at the bottom of the Layers Panel and choose Curves from the pop-up 
menu. The Curves adjustment will appear and the active selection will automati-
cally be applied to the attached layer mask. The areas that were selected will be 
the white parts of the mask. This is the area where the adjustment will be visible. 

In the Curves Properties Panel, we want to inject some color into the isolated tree 
shapes. It looks like the other tree shapes on the umbrella are a cyan color, so we’ll 
try to add that. We’ll click on the color menu at the top of the curve chart and 
choose Red from the dropdown menu. This curve will allow us to add or remove 
red and cyan, which is red’s opposite. We’ll click on the upper right point on the 
curve line and drag it down. This takes the brightest parts of the isolated area and 
makes them more cyan. We’ll move it down until we can better make out the tree 
shapes in the umbrella. 

We selected everything outside of the tree 
shapes and filled the channel with white.

We inverted the mask so that the tree 
shapes are the only area that is selected.
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Final Retouching

At this point, the only other thing this image could use is a little retouching. We’ll 
create a new, empty layer at the top of the layer stack, on which to place the re-
touching. We’ll activate the Spot Healing Brush and make sure that the Sample 
All Layers check box (in the Options Bar) is turned on. This will allow the tool to 
work on an empty layer.  

We’ll use the Spot Healing Brush to get rid of some 
of the distracting elements, such as the little bag 
in the lower right corner of the frame. It’s really a 
personal preference as to how much should be re-
moved. I just removed some of the smaller spots 
around the edges of the frame that I found to be a 
little distracting. 

The tree shapes are isolated by a layer mask attached to a Curves Adjustment Layer. The top, 
right point on the red curve is being dragged down and this is adding cyan to the area.

The Spot Healing Brush is 
being used to remove some 
smaller distracting elements.


